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This site can't be reached
dev.bemasoftwareservices.com took too long to respond.

Try:
* Checking the connection
e Checking the proxy and the firewall
* Running Windows Network Diagnostics

ERR_CONNECTION_TIMED_OUT
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Monitoring Types: White Box

« AKA Observability

« Common Metrics and Components
« Response Time
* Request Throughput
* Error Rate
* Apdex
* Transactions
* Traces

« Agent-Based vs. Open Telemetry
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Monitoring Types: Black Box

 External polling: « SQL Database metrics
* Response times « DTU Utilization
* Internet infrastructure « CPU Utilization
* TLS certificate monitoring « Data 10 Percentage
- Application server metrics: * Disk IO Percentage
« CPU
 Memory
e Disk 10
» Disk space
* Network Throughput

Burst Credits
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Add BEMA’s dashboard to eI
your Azure environment!

Mmm pibbil ik

* Displays data already R —
collected by your Azure |
environment m.wmuw WW lnHMWW

» Dashboards are a no-cost e
Azure platform feature! —



https://bemasoftwareservices.com/azuredash
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The Troubleshooting Process

nat am | seeing?

nat can | learn from my monitoring tools?
nat can | learn from my web server?

nat can | learn from my database?

BwN e
= zz=
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Digging Deeper: Web Server

* Rock Exceptions Ul

* Rock Application Log File
 C:\inetpub\wwwroot\App Data\Logs\RockApplication.csv
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Rock Application Log File

Get-Content -Wait “C:\inetpub\wwwroot\App Data\Logs\RockApplication.csv” -Tail 100

EN Adrninistrator: Windows PowerShell — O >

Get-Content
ication Started Successfully
ication Ended: Hu:flucEnulrunmenf {Process ID:
H”_HSSENb rInitializer started by Rockleb
AM,Application Starting
AM,Checking for EntityFramework Migrations
AM, Configuring SaveHooks
AM,Initializing ck
AM, Configuring Date Settings
AM, Applying Plugin Migrations
AM,Reloading Cache
HH,Luadlng Cache From Database
AH,deatafiﬂc Attributes From Web.Config Setting
arting the Message Bus
» 5t the Web Farm (¢
AM, ReclrfErl g HTTP Modules
HH_Inlflall ing Lava Engine
AM,Starting Job Scheduler
AM,Starting the Web Farm (

P R o ST R R

WA

G

[

S N I U T N N R N Y LN L N LN LS S S LSS

[

&H;&hhlliatluﬂ Ended: Hosi
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Application Shutdown Reasons

BinDirChangeOrDirectoryRename A change was made to the Bin folder or its contents.
Typically a plugin install or update.
ConfigurationChange Application configuration file was changed
(web.config, web.ConnectionStrings.config)
InitializationError The application was unable to initialize, likely due to
an incorrect configuration (connection string, etc.).
UnloadAppDomainCalled The “Restart Rock” button was clicked in the Rock UlI.
HostingEnvironment The hosting environment shut down the application

domain (app pool recycle, other reasons).

ASP.NET Shutdown Reasons Enum
Recommended AV Exclusions

What if no “Application Ended” entry is logged?
Application crash!


https://learn.microsoft.com/en-us/dotnet/api/system.web.applicationshutdownreason?view=netframework-4.8.1
https://learn.microsoft.com/en-us/troubleshoot/developer/webapps/aspnet/www-administration-management/exclude-folders-antivirus-scanning
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Digging Deeper: Web Server

* Rock Exceptions Ul

* Rock Application Log File
 C:\1netpub\wwwroot\App Data\Logs\RockApplication.csv

« Windows Application Logs
 Application Log
 Web Server (IIS) custom view
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Application Log

2] Event Viewer - *
File Action View Help
LIRS

[ 57] E\r.ent Viewer (Local) Application Number of events: 5,167 Actions
v _‘—# Custom Views
v [ Server Roles

“F  Filtered: Log: Application; Source: ; Event ID: 1000. Murnber of events: 15 Application -

T Remate Desktop Serv||| | cyel Date and Time Source EventID Task Category || OpenSavedLog..
? E WeitSe?er é”SJ . " 024 5: Eprlia i F Create Custom View...
= i m'"l_' e e @ Error §/28/2024 £:49:49 PM Application Error (100) Import Customn View...
v [ indows Logs =
- e &¥ Error AT ication Error
® g Apphcatlin (1] 6/28/2024 £:47:53 PM Application E (100) Clear Log..
- @ Error 6/28/2024 4:45:25 PM Application Error (100) .
i security = - ¥ Filter Current Log...
) Setup '@' Error 6/28/2024 4:42:42 PM Application Error (100) )
] System @cError 6/28/2024 8:19:33 AM Application Error (100 o Clear Filter
Forwarded Events . Properties
> R %l]plications and Services Lo Event 1000, Application Error X ind
ind...
_;j Subscriptions General  Details

Save Filtered Log File As...

o TED

Faulting application name: w3wp.exe, version: 10.0.20348.1, time stamp: 0x405edc14 Attach a Task To this Log...
Faulting module name: unknown, version: 0.0.0.0, time stamp: Ox 00000000 Save Filter to Custom View...
Exception code: ec00000fd )
Fault offset: 0xD0007f7ba7f37, View »
Faulting process id: (1840 Refresh
Faulting application start time: (x01da blecf e res
Faulting application path: c\windows\syste petsniwiwp.exe ﬂ Help »
Faulting medule path: unknown
Report |d: f37f3b0c-9dfe-46c6-975d-eec57ef1d620 Event 1000, Application Error -
Faulting package full name: B
Faulting package-relative application ID: [E] Event Properties
E Attach Task To This Event...
52 Copy »
H Save Selected Events...
|G| Refresh
Log Name: Application ﬂ Help ’
Source: Application Error Logged: 6/28/2024 5:25:04 PM
Event ID: 1000 Task Category:  (100)
Level: Error Keywords: Classic
User: N/A Computer: rock-sandbox
OpCode: Info

More Information:  Event Log Online Help
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Web Server (11S) Log

2] Event Viewer - *
File Action View Help
Aol AN:4
[ 57] Event Viewer (Local) Web Server (IIS) MNumber of events: 126 Actions
v ;# 3!522::;:]; ¥ MNumber of events: 126 Web Server (IIS) .
T Remote Desktop Serv||| | cyel Date and Time N ~] | &= Open Saved Log...

Source Event D Task Category

? Web Server (IIS)
“F Administrative Events
v _!_. Windows Logs

1 Information ¥ Create Custom View..,

®Information Import Customn View...

& Application ®Information 7/13/2024 2:00:00 AM WAS 3076 None “F Filter Current Custom View...
. ®Information 7/12/2024 2:00:00 AM WAS 5076 MNone _ )

i Security . D Properties

] setup ®Informatlon 7/11/2024 2:00:00 AM WAS 3076 None o )

] System = 5 % Find...

Save All Events in Custom View As...

) = F.orw.arded E\.rents. Event 5076, WAS = I
_F‘| Applications and Services Lo Export Custom View...
|4 Subscriptions General Details

Copy Custom View...

A worker process with process id of '532' serving application pool 'DefaultAppPool’ has requested a recycle because it reached its scheduled recycle time. Attach Task To This Custom View...

View »
|G Refresh
Help »
Event 5076, WAS -

D Event Properties
E Attach Task To This Event...
H Save Selected Events...

Bz Copy »
|G Refresh
Help »
Log Mame: Systemn
Source: WAS Logged: 7/15/2024 2:00:00 AM
Event ID: 5076 Task Category: Mone
Level: Information Keywords: Classic
User: N/A Computer: rock-sandbox
OpCode: Info

More Information:  Event Log Online Help
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Digging Deeper: Web Server

* Rock Exceptions Ul

* Rock Application Log File
 C:\1netpub\wwwroot\App Data\Logs\RockApplication.csv

* Windows Application Logs
 Application Log
 Web Server (IIS) custom view

* Rock Exception Log File
 C:\1netpub\wwwroot\App Data\Logs\RockExceptions.csv

* [IS Logs
 C:\inetpub\logs\LogFiles\W3SV(C1

* [IS Worker Process Requests
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IS Worker Process Requests

IIS Manager > [Server Name] > Worker Processes > [App Pool Name]

@ﬁ Internet Information Services (1I5) Manager

- hed
<« €5 » ROCK-SANDBOX » Wt @
| 1

File View Help

Connections . Actions

(*=1]

Q- & J Requests @

bﬁ Start Page — Displays the current requests for the worker process

¥ ROCK-SANDEBOX (ROCK-SANDBOX\Administrator)

Currently viewing the requests of process ID 1512 associated with application pool 'DefaultippPool’ with more than '0' secend(s) running.
Filter: - W Go ~ (G Show Al
Website ID Url

Verb Client IP State
1

/personi1 GET 172.20.3.17

Module Mame Time Elapsed

ExecuteRequestH..  ManagedPipel... 3281



Crash Troubleshooting: ~=BEMA

Memory Dumps

* The best way to troubleshoot a crashing Rock instance
« Snapshot of the application state at a moment in time
« Capture with Windows Error Reporting
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WER Configuration

e HKLM\SOFTWARE\Microsoft\Windows\Windows Error
Reporting\LocalDumps\w3wp.exe

* DumpCount (DWORD): Limit number of store dump files
(Recommend 3-5 on production system)

* DumpFolder (Expandable String): Dump file location
* DumpType (DWORD): 2 (Full Dump)

ﬁ Registry Editor

File Edit WYiew Favorites Help
Computer\ HEEY_LOCAL MACHINENSOFTWARE\Microsoft\Windows'\Windows Error Reportingh LocalDumpshw3wp.exe
|| UpdateApi A || Name

= Type Data

W Wn:l WS 'E.rlru:u r.REFIPD r’lc.lng ab (Default] REG_SZ (walue not set) . .
jDumpCount  REGDWORD  0x0000Doos (3 WER Configuration
C;Dn:;ntp ab| DumpFolder REG_EXPAMD_SZ %ProgramData®\BEMANCrashDumps
Hangs iz DumpType REG_DWORD CrcDOO0O0002 (2) Refe re n C e

v LocalDumps
L wlwp.exe

- RuntimeExceptionHelperModules
TermReason

Windows Search


https://learn.microsoft.com/en-us/windows/win32/wer/wer-settings#windows-error-reporting-subkey
https://learn.microsoft.com/en-us/windows/win32/wer/wer-settings#windows-error-reporting-subkey
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Memory Dump Analysis Tools

 Debug Diagnostic Tool v2

» Easiest to get useful information without specialized knowledge. Pre-
configured analyses that can be run on your memory dump file.

* Visual Studio Enterprise

* The Enterprise edition of Visual Studio allows importing and analyzing
memory dump files using the familiar debugging tools in Visual Studio.

* WInDbq

» Low-level Windows debugging tool. Useful for finding answers you
can't find with the other two tools (or if you don’t have a Visual Studio

Enterprise license).



https://www.microsoft.com/en-us/download/details.aspx?id=103453
https://learn.microsoft.com/en-us/visualstudio/debugger/using-dump-files?view=vs-2022
https://learn.microsoft.com/en-us/windows-hardware/drivers/debugger/

. 4=BEMA
Demo: Memory Dump Debugging

E CA\MemoryDumps\ScheduleJobExecuting.dmp - WinDbg 1.2402.24001.0
Home View Breakpoints Time Travel Model Scripting Source Memory Command

Restart e | ; e E
B Stop Debuggi I n L]
e DEILERI Settings |Source | Assembly  Local Feedback . r M r
A Detach Help - -

Flow Control Reverse Flow Control End Preferences Help

* Tess Ferrandez Blog

Executable search path is:
Windows 1@ Version 20348 MP (2 procs) Free x64

Product: Server, suite: TerminalServer DataCenter SingleUserTS .
Edition build lab: 20348.1.amd64fre.fe release.210507-1500 L e u q q e r X e n S I O n

Debug session time: Mon Jul 15 11:31:59.000 2024 (UTC - 4:00)

System Uptime: © days 3:58:34.839 .
Process Uptime: © days 3:57:40.000 for WI n qu

0 Alowap Alquassesig

For analysis of this file, run lanalyze -v
ntdll!NtWaitForsingleObject+exi4:

00007118 f8bae254 c3 ret

0:000>

‘Watch ¥ 52 X ||Stack

Name Value Type Frame Index
Add new watch expression 0x0 ntdIlNtWaitFor!

0x1 KERNELBASE!Wai
[0x2] w3wphost!WP_IP
[0x3] w3wphost!AppHc
[0x4] w3wplwmain+0x
[0x5] w3wp!_wmainCF
0xE kernel32!BaseThr
0x7’ ntdll!RtlUserThre:
4

Locals | Watch Threads | Stack = Breakpoints


https://www.tessferrandez.com/tags/#debugging
https://learn.microsoft.com/en-us/dotnet/framework/tools/sos-dll-sos-debugging-extension
https://learn.microsoft.com/en-us/dotnet/framework/tools/sos-dll-sos-debugging-extension

Digging Deeper: Database

re Database Properties - rockprod

* Query Store: database
“black box”

« Key Settings
« Max Size (MB) — consider
2 GB

 Stale Query Threshold
(Days)

Microsoft Learn:
Monitoring Performance
with Query Store
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I'Seleclapnge
| & General
# Options
# Configure SLO
# Change Tracking
K Permissions
F Extended Properties
# Query Store

‘Connection

1 9? View connection properties

Progress

Ready

—DXW

IT Script ~ @ Help ‘

ERE
~ General
Operation Mode (Actual)
Operation Mode (Requested)
~  Monitoring
Data Flush Interval (Minutes) 15

Read write
Read write

Statistics Collection Interval 1 Hour
~ Query Store Retention
Max Plans Per Query 200
Max Size (MB) 2000
Query Store Capture Mode Auto
Size Based Cleanup Mode Auto
Stale Query Threshold (Days) 30
Wait Statistics Capture Mode On

Data Flush Interval (Minutes)
The frequency at which query store data is flushed and persisted to disk.

Current Disk Usage

[ | rockprod
[ | Query Store Used

388 GB
98.0 MB

M Query Store Available 1.9GB
B Query Store Used 98.0 MB

Purge Query Data


https://learn.microsoft.com/en-us/sql/relational-databases/performance/monitoring-performance-by-using-the-query-store?view=sql-server-ver16
https://learn.microsoft.com/en-us/sql/relational-databases/performance/monitoring-performance-by-using-the-query-store?view=sql-server-ver16
https://learn.microsoft.com/en-us/sql/relational-databases/performance/monitoring-performance-by-using-the-query-store?view=sql-server-ver16

_=BEMA

SOFTWARE SERVICES

Demo: Query Store

Top Resource Consumers [rockprod] +# X

Top 25 resource consumers for database rockprod. Time period: Last hour ending at 7/15/2024 23:41

Mettic Duraton (m) sl < [2] @[] L] sy e Learn More:
o] @ o SOL Skills Query Store
o e - Blog
;o g = « Erin Stellato: Why You
Need Query Store

20000-

22:45 22:50 22:55 23:00 2 L4 Erl n Stel |ato : Querv Store

query id b

Best Practices

Query 1: Query cost (relative to the batch): 100%
SELECT [Extentl].[Id] AS [Id], [Extentl].[IsSystem] AS [IsSystem], [Extentl].[AttributeId] AS [Attributeld’

- - @ A
E ot d L Ind Seek N“, C1 d |
T Compure Scelar i (Arerimurevalue . (T¥ PariryI
Cost: 0 % Cost: 0 % {Innex Join) S yi-
Cost: 0 % Cost: 46 %
5 gl

Key Lookup (Clustered)
[AttributeValue] . [PK_dbo.Att..
Cost: 54 %

Compute Scalar
Cost: 0 %



https://www.sqlskills.com/blogs/erin/category/query-store/
https://www.sqlskills.com/blogs/erin/category/query-store/
https://www.youtube.com/watch?v=DAgkwoIST9U
https://www.youtube.com/watch?v=DAgkwoIST9U
https://www.youtube.com/watch?v=bJR6eBcp2-Q
https://www.youtube.com/watch?v=bJR6eBcp2-Q
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Performance Is a Feature

« Performance = Scalability
* Performance = Cost Savings
« Performance = Uptime

« Performance or provisioning problem?
* |s it a broad/baseline issue or a specific feature/traffic problem?
« Infrastructure design and code optimization work together
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The Hot Path: Perf-Critical Code

* Logic or code executed frequently or simultaneously by many
sessions or users

« Optimization
« Caching: Re-use work we've already done.
 Persisted Datasets: Pre-computed data for data-heavy pages.
e Lava / SQL Optimization

 Traffic Offloading: Content Delivery Network (CDN)
« Cloudflare

» Load Testing
* Locust



https://www.cloudflare.com/
https://locust.io/

The Hot Path: Case Study
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Apdex Score ©
95th Percentile -0.91
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Q+A

bemasoftwareservices.com/rockyourops
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